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SOFTWARE NOTES 

Live This Program is designed to be used with Ableton Live. (MAX49 comes with Ableton Live Lite 
Akai Edition.) 

Reason 

For use with Propellerhead Reason. This Program supports the Reason Remote protocol with 
supplied codec files, which you may need to install. Each module in Reason will automatically 
map itself to MAX49's controllers. This allows you to use a single MAX49 preset to control all of 
the modules in Reason. 

Cubase For use with Steinberg Cubase. 

Logic Pro For use with Apple Logic Pro. 

FL Studio For use with Image-Line FL Studio. 

GURU For use with FXpansion's GURU. 

Pro Tools  For use with Pro Tools. 

GM Drums A standard General MIDI drum and controller mapping, ideal for general drum use. 

Chrmatic A general mapping in which MAX49's PADS use a chromatic scale. 

Generic User Programs – for your own use! 

 
The included Programs are intended to be a starting point for your use. You can easily edit and store 
your own Programs (see the EDIT MODE section of the included MAX49 Quickstart Guide). The 
software mentioned in this manual allows incredible amounts of control with MAX49. By using 
multiple MIDI channels, controllers, pad modes and program changes, you can easily create some 
incredible music. 
 
Enjoy! 
 
The Akai Professional Team 
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Ableton Live 
  

Setup 
 
To install and use the Live controller map, follow these instructions:  
 
1. Download the Ableton Live controller map to your computer from the included CD or from www.akaipro.com/max49. 

2. With Live closed, copy the entire MAX49 folder (the folder itself, not just its contents) to the following location in your 
computer:  

 
Windows 7 or Windows Vista: 
C:\Users\[YourUserName]\AppData\Roaming\Ableton\Live [VersionNumber]\Preferences\User Remote Scripts 

Note: The AppData folder is a hidden folder. To make this folder visible: 
1. On your PC, open Computer. 
2. Select the Organize menu at the top of the window, and choose Folder and search options. 
3. In the window that opens, select the View tab. 
4. Scroll down, locate, and select Show hidden files and folders. 
5. Click Apply, then OK. 

 
Windows XP: 
C:\Documents and Settings\[YourUserName]\Application Data\Ableton\Live [VersionNumber]\Preferences\User 
Remote Scripts 

Note: The Application Data folder is a hidden folder. To make this folder visible: 
1. On your PC, open My Computer. 
2. Select the Tools menu at the top of the screen, and choose Folder Options. 
3. In the window that opens, select the View tab. 
4. Scroll down, locate, and select Show hidden files and folders. 
5. Click Apply, then OK. 

 
Mac 
Macintosh HD  Users  [YourUserName]  Library  Preferences  Ableton  Live [VersionNumber]  User 
Remote Scripts 

 
3. Connect MAX49 to your computer with the included USB cable. Open Ableton Live. 

4. On MAX49, select the Live or LiveKS Program. Press the VALUE DIAL to load it. 
Note: If you have edited MAX49's Programs and are unable to load the Program, use the supplied Vyzex editor to 
load the Factory Preset Bank and "PUT" or download the factory preset bank into MAX49. 

5. Open Live's Preferences window. 
Windows: Options  Preferences. 
Mac: Live Menu  Preferences. 

6. Select the MIDI Sync tab on the left-hand side. 

7. Select MAX49 as the Control Surface.  
Windows: Set the Control Surface to MAX49 and set the Input and Output to USB Audio Device. 

 Mac: Set the Control Surface, Input, and Output to MAX49. 
 Note: MAX49 will be the last item in the Control Surface drop-down menu. 

8. Under MIDI Ports, next to Input, set the Track and Remote settings to On. This allows Live to accept Track and 
Remote MIDI from MAX49. 

9. Close the Preferences window. 
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Live 
 
When using MAX49's Live Program, the controls' behavior is as follows: 
 
TRANSPORT CONTROLS (Play, Stop, Rec, etc.): These controls are set to MIDI CC, so they will work accordingly in the 
software. 
 
BANK 1-8:  

TOUCH FADERS: These control various parameters in your software Devices (Instruments, Audio Effects, etc.).  

S-SWITCHES: These switch the TOUCH FADERS between various "banks" so you can control different sets of 
parameters within that Device. 

 
BANK 9-16:  

TOUCH FADERS: These control the volume level of Tracks 1-8. 

S-SWITCHES: These record-arm Tracks 1-8. 
 
BANK 17-24:  

TOUCH FADERS: These control the Send A levels of Tracks 1-8. 

S-SWITCHES: These record-arm Tracks 1-8. 
 
BANK 25-32:  

TOUCH FADERS: These control the Send B levels of Tracks 1-8. 

S-SWITCHES: These record-arm Tracks 1-8. 
 
Note: [SEQ CC] is set to MIDI CC #74, so MAX49 will send CC #74 anytime its Sequencer is on. You can change the 
CC# in Edit Mode. See the EDIT MODE section of the included MAX49 Quickstart Guide. 
 

LiveKS 
 
This Program is almost the same as the Live Program described above, but this version allows you to turn MAX49's 
Sequencer on/off by pressing keys on its KEYBOARD. To do this: 
 
1. Press SEQ SELECT so it is lit. 

2. Press ON/OFF so it is lit. 

3. Press and hold a key on MAX49's KEYBOARD. The Sequence will play (in that key) while the key is being held. 
When you release the key, the Sequence will stop.  

Note: (To "latch" the Sequencer, press [LATCH] so it is lit. When this button is activated, Sequencer playback will 
continue even after the key is released.) 
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Propellerhead Reason 
 

Reason allows for vast control of its parameters. Propellerhead Software has developed a way to remap a single control 
surface to each of the modules in Reason. This protocol is called Reason Remote. We have included all the files 
necessary to enable Reason to find MAX49 and map its controls to whatever module you have selected in the sequencer. 
 

Setup 
 
1. Install the MAX49/Reason preset file.  

 
Note: You must have the following version of Reason: 

• Windows 7/Vista/XP: Version 3.0.4 (or later)  
• Mac: Reason Version 3.0.5 (or later) 

 
Windows 7/Vista 

1. Double-click the Computer icon on the desktop, then double-click Local Disk (C:). 
2. Towards the upper-left of the window, select the Organize menu, and choose Folder and Search Options. 
3. At the top of the window that opens, select the View tab. 
4. In the list titled Advanced settings, double-click the Show hidden files and folders option. 
5. Click Apply, then click OK. The Folder Options window will close. 
6. The Akai Reason Remote Files folder (on the included CD) contains two folders: Lua Codecs and Maps. 

Open the Lua Codecs folder. 
7. Copy the folder titled Akai into the following directory on your computer: C:\Program Data\Propellerhead 

Software\Remote\Codecs\Lua Codecs. 
8. Next, in the Akai Reason Remote Files folder, open the folder titled Maps 
9. Copy the AkaiMAX49_100 file to the following directory on your computer: C:\Program Data\Propellerhead 

Software\Remote\Maps. 
10. Connect MAX49 to your computer with the included USB cable. 
11. Open Reason and select the Edit menu from the top of the screen, and open Preferences. 
12. Using the pull-down menu at the top of the Preferences window, choose Control Surfaces And Keyboards. 
13. Click the Add button. 
14. Select Akai from the Manufacturer list. 
15. Set the In Port to USB Audio Device. 
16. Set the Out Port to USB Audio Device. 
17. Click Ok and then close the Preferences window.  

 
Windows XP 

1. The Akai Reason Remote Files folder (on the included CD) contains two folders: Lua Codecs and Maps. 
Open the Lua Codecs folder. 

2. Copy the folder titled Akai into the following directory on your computer: C:\Documents and settings\All 
Users\Application Data\Propellerhead Software\Remote\Codecs\Lua Codecs. 

3. Next, in the Akai Reason Remote Files folder, open the folder titled Maps. 
4. Copy the AkaiMAX49_100 file to the following directory on your computer: C:\Documents and settings\All 

Users\Application Data\Propellerhead Software\Remote\Maps. 
5. Connect MAX49 to your computer with the included USB cable. 
6. Open Reason and select the Edit menu from the top of the screen, and open Preferences. 
7. Using the pull-down menu at the top of the Preferences window, choose Control Surfaces And Keyboards. 
8. Click the Add button. 
9. Select Akai from the Manufacturer list. 
10. Set the In Port to USB Audio Device. 
11. Set the Out Port to USB Audio Device. 
12. Click Ok and then close the Preferences window.  
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Macintosh  

1. The Akai Reason Remote Files folder (the same folder where you found this guide) contains two folders: 
Lua Codecs and Maps. Open the Lua Codecs folder.  

2. Copy the folder titled Akai into the following directory on your computer: Macintosh HD\Library\Application 
Support\Propellerhead Software\Remote\CODECS\LUA CODECS.  

3. Next, in the Akai Reason Remote Files folder, open the folder titled Maps.  
4. Copy the AkaiMAX49_100 folder to the following directory on your computer: Macintosh 

HD\Library\Application Support\Propellerhead Software\Remote\Maps.  
5. Connect MAX49 to your computer with the included USB cable. 
6. Open Reason and select the Edit menu from the top of the screen, and open Preferences.  
7. Using the pull-down menu at the top of the Preferences window, choose Control Surfaces And Keyboards.  
8. Click the Add button.  
9. Select Akai from the Manufacturer list.  
10. Set the In Port to Akai MAX49 Port 1.  
11. Set the Out Port to Akai MAX49 Port 1.  
12. Click Ok and then close the Preferences window.  

 
2. On MAX49, select the Reason or ReasonKS Program. Press the VALUE DIAL to load it. 

Note: If you have edited MAX49's Programs and are unable to load the Program, use the supplied Vyzex editor to 
load the Factory Preset Bank and "PUT" or download the factory preset bank into MAX49. 

 

Reason 
 
To see how the MAX49 controls are mapped to each module in Reason, please refer to the tables on the following pages. 
You can always change how controllers are mapped by modifying the MAX49.remotemap file. This will allow you to 
customize how Reason and your MAX49 work. 
 

ReasonKS 
 
This Program is almost the same as the Reason Program described above, but this version allows you to turn MAX49's 
Sequencer on/off by pressing keys on its KEYBOARD. To do this: 
 
1. Press SEQ SELECT so it is lit. 
2. Press ON/OFF so it is lit. 
3. Press and hold a key on MAX49's KEYBOARD. The Sequence will play (in that key) while the key is being held. 

When you release the key, the Sequence will stop.  
Note: (To "latch" the Sequencer, press [LATCH] so it is lit. When this button is activated, Sequencer playback will 
continue even after the key is released.) 
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Reason/MAX49 Mappings 

 
 

MIXER 6:2 
 

 

COMBINATOR 
 

 
 

::: GLOBAL CONTROLLERS :::   ::: MASTER KEYBOARD ::: 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Stop Stop  Keyboard Keyboard 
Play Play  Pitch Bend Pitch Bend 

Record Record  Mod Wheel Mod Wheel 
Switch 7 Device Select Up  Expression Expression 
Switch 8 Device Select Down 

Switch 15 Program Down 
Switch 16 Program Up 

 

 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Channel 1 Level  Switch 1 Channel 1 Mute 
Fader 2 Channel 2 Level  Switch 2 Channel 2 Mute 
Fader 3 Channel 3 Level  Switch 3 Channel 3 Mute 
Fader 4 Channel 4 Level  Switch 4 Channel 4 Mute 
Fader 5 Channel 5 Level  Switch 5 Channel 5 Mute 
Fader 6  Channel 6 Level  Switch 6  Channel 6 Mute 
Fader 7   Switch 7  
Fader 8 Master Level  Switch 8  
     
Fader 9 Channel 1 Pan  Switch 9 Channel 1 Solo 
Fader 10 Channel 2 Pan  Switch 10 Channel 2 Solo 
Fader 11 Channel 3 Pan  Switch 11 Channel 3 Solo 
Fader 12 Channel 4 Pan  Switch 12 Channel 4 Solo 
Fader 13 Channel 5 Pan  Switch 13 Channel 5 Solo 
Fader 14 Channel 6 Pan  Switch 14 Channel 6 Solo 
Fader 15   Switch 15  
Fader 16   Switch 16  
     
Fader 17 Channel 1 Aux Send    
Fader 18 Channel 2 Aux Send    
Fader 19  Channel 3 Aux Send    
Fader 20 Channel 4 Aux Send    
Fader 21 Channel 5 Aux Send    
Fader 22 Channel 6 Aux Send    
Fader 23     
Fader 24 Aux Return    

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Rotary 1  Switch 1 Button 1 
Fader 2 Rotary 2  Switch 2 Button 2 
Fader 3 Rotary 3  Switch 3 Button 3 
Fader 4 Rotary 4  Switch 4 Button 4 
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MIXER 14:2 
 
GROUP 1: 
 

 

MAX49 
CONTROL 

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL 

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Channel 1 Level Levels Pan Mutes1 1-14  Switch 1 Channel 1 Mute Levels Pan Mutes1 1-14 

Fader 2 Channel 2 Level Levels Pan Mutes1 1-14  Switch 2 Channel 2 Mute Levels Pan Mutes1 1-14 

Fader 3 Channel 3 Level Levels Pan Mutes1 1-14  Switch 3 Channel 3 Mute Levels Pan Mutes1 1-14 

Fader 4 Channel 4 Level Levels Pan Mutes1 1-14  Switch 4 Channel 4 Mute Levels Pan Mutes1 1-14 

Fader 5 Channel 5 Level Levels Pan Mutes1 1-14  Switch 5 Channel 5 Mute Levels Pan Mutes1 1-14 

Fader 6  Channel 6 Level Levels Pan Mutes1 1-14  Switch 6  Channel 6 Mute Levels Pan Mutes1 1-14 

Fader 7 Channel 7 Level Levels Pan Mutes1 1-14  Switch 7   

Fader 8 Master Level All Groups  Switch 8   

       

Fader 9 Channel 8 Level Levels Pan Mutes1 1-14  Switch 9 Channel 8 Mute Levels Pan Mutes1 1-14 

Fader 10 Channel 9 Level Levels Pan Mutes1 1-14  Switch 10 Channel 9 Mute Levels Pan Mutes1 1-14 

Fader 11 Channel 10 Level Levels Pan Mutes1 1-14  Switch 11 Channel 10 Mute Levels Pan Mutes1 1-14 

Fader 12 Channel 11 Level Levels Pan Mutes1 1-14  Switch 12 Channel 11 Mute Levels Pan Mutes1 1-14 

Fader 13 Channel 12 Level Levels Pan Mutes1 1-14  Switch 13 Channel 12 Mute Levels Pan Mutes1 1-14 

Fader 14 Channel 13 Level Levels Pan Mutes1 1-14  Switch 14 Channel 13 Mute Levels Pan Mutes1 1-14 

Fader 15 Channel 14 Level Levels Pan Mutes1 1-14  Switch 15   

Fader 16    Switch 16   

       

Fader 17 Channel 1 Pan Levels Pan Mutes1 1-14     

Fader 18 Channel 2 Pan Levels Pan Mutes1 1-14     

Fader 19  Channel 3 Pan Levels Pan Mutes1 1-14     

Fader 20 Channel 4 Pan Levels Pan Mutes1 1-14     

Fader 21 Channel 5 Pan Levels Pan Mutes1 1-14     

Fader 22 Channel 6 Pan Levels Pan Mutes1 1-14     

Fader 23 Channel 7 Pan Levels Pan Mutes1 1-14     

Fader 24       

       

Fader 25 Channel 8 Pan Levels Pan Mutes1 1-14     

Fader 26 Channel 9 Pan Levels Pan Mutes1 1-14     

Fader 27  Channel 10 Pan Levels Pan Mutes1 1-14     

Fader 28 Channel 11 Pan Levels Pan Mutes1 1-14     

Fader 29 Channel 12 Pan Levels Pan Mutes1 1-14     

Fader 30 Channel 13 Pan Levels Pan Mutes1 1-14     

Fader 31 Channel 14 Pan Levels Pan Mutes1 1-14     

Fader 32       
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MIXER 14:2 (continued) 
 
GROUP 2: 
 

 

MAX49 
CONTROL 

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Channel 1 Level Levels Sends Mutes1 1-14  Switch 1 Channel 1 Mute Levels Sends Mutes1 1-14 

Fader 2 Channel 2 Level Levels Sends Mutes1 1-14  Switch 2 Channel 2 Mute Levels Sends Mutes1 1-14 

Fader 3 Channel 3 Level Levels Sends Mutes1 1-14  Switch 3 Channel 3 Mute Levels Sends Mutes1 1-14 

Fader 4 Channel 4 Level Levels Sends Mutes1 1-14  Switch 4 Channel 4 Mute Levels Sends Mutes1 1-14 

Fader 5 Channel 5 Level Levels Sends Mutes1 1-14  Switch 5 Channel 5 Mute Levels Sends Mutes1 1-14 

Fader 6  Channel 6 Level Levels Sends Mutes1 1-14  Switch 6  Channel 6 Mute Levels Sends Mutes1 1-14 

Fader 7 Channel 7 Level Levels Sends Mutes1 1-14  Switch 7   

Fader 8    Switch 8   

       

Fader 9 Channel 8 Level Levels Sends Mutes1 1-14  Switch 9 Channel 8 Mute Levels Sends Mutes1 1-14 

Fader 10 Channel 9 Level Levels Sends Mutes1 1-14  Switch 10 Channel 9 Mute Levels Sends Mutes1 1-14 

Fader 11 Channel 10 Level Levels Sends Mutes1 1-14  Switch 11 Channel 10 Mute Levels Sends Mutes1 1-14 

Fader 12 Channel 11 Level Levels Sends Mutes1 1-14  Switch 12 Channel 11 Mute Levels Sends Mutes1 1-14 

Fader 13 Channel 12 Level Levels Sends Mutes1 1-14  Switch 13 Channel 12 Mute Levels Sends Mutes1 1-14 

Fader 14 Channel 13 Level Levels Sends Mutes1 1-14  Switch 14 Channel 13 Mute Levels Sends Mutes1 1-14 

Fader 15 Channel 14 Level Levels Sends Mutes1 1-14  Switch 15   

Fader 16    Switch 16   

       

Fader 17 Channel 1 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 18 Channel 2 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 19  Channel 3 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 20 Channel 4 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 21 Channel 5 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 22 Channel 6 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 23 Channel 7 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 24       

       

Fader 25 Channel 8 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 26 Channel 9 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 27  Channel 10 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 28 Channel 11 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 29 Channel 12 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 30 Channel 13 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 31 Channel 14 Aux 1 Send Levels Sends Mutes1 1-14     

Fader 32       
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MIXER 14:2 (continued) 
 
GROUP 3: 
 

 

MAX49 
CONTROL 

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Channel 1 Level Levels Sends Mutes2 1-14  Switch 1 Channel 1 Mute Levels Sends Mutes2 1-14 

Fader 2 Channel 2 Level Levels Sends Mutes2 1-14  Switch 2 Channel 2 Mute Levels Sends Mutes2 1-14 

Fader 3 Channel 3 Level Levels Sends Mutes2 1-14  Switch 3 Channel 3 Mute Levels Sends Mutes2 1-14 

Fader 4 Channel 4 Level Levels Sends Mutes2 1-14  Switch 4 Channel 4 Mute Levels Sends Mutes2 1-14 

Fader 5 Channel 5 Level Levels Sends Mutes2 1-14  Switch 5 Channel 5 Mute Levels Sends Mutes2 1-14 

Fader 6  Channel 6 Level Levels Sends Mutes2 1-14  Switch 6  Channel 6 Mute Levels Sends Mutes2 1-14 

Fader 7 Channel 7 Level Levels Sends Mutes2 1-14  Switch 7   

Fader 8    Switch 8   

       

Fader 9 Channel 8 Level Levels Sends Mutes2 1-14  Switch 9 Channel 8 Mute Levels Sends Mutes2 1-14 

Fader 10 Channel 9 Level Levels Sends Mutes2 1-14  Switch 10 Channel 9 Mute Levels Sends Mutes2 1-14 

Fader 11 Channel 10 Level Levels Sends Mutes2 1-14  Switch 11 Channel 10 Mute Levels Sends Mutes2 1-14 

Fader 12 Channel 11 Level Levels Sends Mutes2 1-14  Switch 12 Channel 11 Mute Levels Sends Mutes2 1-14 

Fader 13 Channel 12 Level Levels Sends Mutes2 1-14  Switch 13 Channel 12 Mute Levels Sends Mutes2 1-14 

Fader 14 Channel 13 Level Levels Sends Mutes2 1-14  Switch 14 Channel 13 Mute Levels Sends Mutes2 1-14 

Fader 15 Channel 14 Level Levels Sends Mutes2 1-14  Switch 15   

Fader 16    Switch 16   

       

Fader 17 Channel 1 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 18 Channel 2 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 19  Channel 3 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 20 Channel 4 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 21 Channel 5 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 22 Channel 6 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 23 Channel 7 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 24       

       

Fader 25 Channel 8 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 26 Channel 9 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 27  Channel 10 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 28 Channel 11 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 29 Channel 12 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 30 Channel 13 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 31 Channel 14 Aux 2 Send Levels Sends Mutes2 1-14     

Fader 32       
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MIXER 14:2 (continued) 
 
GROUP 4: 
 

 

MAX49 
CONTROL 

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Channel 1 Level Levels Sends Mutes3 1-14  Switch 1 Channel 1 Mute Levels Sends Mutes3 1-14 

Fader 2 Channel 2 Level Levels Sends Mutes3 1-14  Switch 2 Channel 2 Mute Levels Sends Mutes3 1-14 

Fader 3 Channel 3 Level Levels Sends Mutes3 1-14  Switch 3 Channel 3 Mute Levels Sends Mutes3 1-14 

Fader 4 Channel 4 Level Levels Sends Mutes3 1-14  Switch 4 Channel 4 Mute Levels Sends Mutes3 1-14 

Fader 5 Channel 5 Level Levels Sends Mutes3 1-14  Switch 5 Channel 5 Mute Levels Sends Mutes3 1-14 

Fader 6  Channel 6 Level Levels Sends Mutes3 1-14  Switch 6  Channel 6 Mute Levels Sends Mutes3 1-14 

Fader 7 Channel 7 Level Levels Sends Mutes3 1-14  Switch 7   

Fader 8    Switch 8   

       

Fader 9 Channel 8 Level Levels Sends Mutes3 1-14  Switch 9 Channel 8 Mute Levels Sends Mutes3 1-14 

Fader 10 Channel 9 Level Levels Sends Mutes3 1-14  Switch 10 Channel 9 Mute Levels Sends Mutes3 1-14 

Fader 11 Channel 10 Level Levels Sends Mutes3 1-14  Switch 11 Channel 10 Mute Levels Sends Mutes3 1-14 

Fader 12 Channel 11 Level Levels Sends Mutes3 1-14  Switch 12 Channel 11 Mute Levels Sends Mutes3 1-14 

Fader 13 Channel 12 Level Levels Sends Mutes3 1-14  Switch 13 Channel 12 Mute Levels Sends Mutes3 1-14 

Fader 14 Channel 13 Level Levels Sends Mutes3 1-14  Switch 14 Channel 13 Mute Levels Sends Mutes3 1-14 

Fader 15 Channel 14 Level Levels Sends Mutes3 1-14  Switch 15   

Fader 16    Switch 16   

       

Fader 17 Channel 1 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 18 Channel 2 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 19  Channel 3 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 20 Channel 4 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 21 Channel 5 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 22 Channel 6 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 23 Channel 7 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 24       

       

Fader 25 Channel 8 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 26 Channel 9 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 27  Channel 10 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 28 Channel 11 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 29 Channel 12 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 30 Channel 13 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 31 Channel 14 Aux 3 Send Levels Sends Mutes3 1-14     

Fader 32       
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MIXER 14:2 (continued) 
 
GROUP 5: 
 

 
 

MAX49 
CONTROL 

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Channel 1 Level Levels Sends Mutes4 1-14  Switch 1 Channel 1 Mute Levels Sends Mutes4 1-14 

Fader 2 Channel 2 Level Levels Sends Mutes4 1-14  Switch 2 Channel 2 Mute Levels Sends Mutes4 1-14 

Fader 3 Channel 3 Level Levels Sends Mutes4 1-14  Switch 3 Channel 3 Mute Levels Sends Mutes4 1-14 

Fader 4 Channel 4 Level Levels Sends Mutes4 1-14  Switch 4 Channel 4 Mute Levels Sends Mutes4 1-14 

Fader 5 Channel 5 Level Levels Sends Mutes4 1-14  Switch 5 Channel 5 Mute Levels Sends Mutes4 1-14 

Fader 6  Channel 6 Level Levels Sends Mutes4 1-14  Switch 6  Channel 6 Mute Levels Sends Mutes4 1-14 

Fader 7 Channel 7 Level Levels Sends Mutes4 1-14  Switch 7   

Fader 8    Switch 8   

       

Fader 9 Channel 8 Level Levels Sends Mutes4 1-14  Switch 9 Channel 8 Mute Levels Sends Mutes4 1-14 

Fader 10 Channel 9 Level Levels Sends Mutes4 1-14  Switch 10 Channel 9 Mute Levels Sends Mutes4 1-14 

Fader 11 Channel 10 Level Levels Sends Mutes4 1-14  Switch 11 Channel 10 Mute Levels Sends Mutes4 1-14 

Fader 12 Channel 11 Level Levels Sends Mutes4 1-14  Switch 12 Channel 11 Mute Levels Sends Mutes4 1-14 

Fader 13 Channel 12 Level Levels Sends Mutes4 1-14  Switch 13 Channel 12 Mute Levels Sends Mutes4 1-14 

Fader 14 Channel 13 Level Levels Sends Mutes4 1-14  Switch 14 Channel 13 Mute Levels Sends Mutes4 1-14 

Fader 15 Channel 14 Level Levels Sends Mutes4 1-14  Switch 15 Channel 14 Mute Levels Sends Mutes4 1-14 

Fader 16    Switch 16   

       

Fader 17 Channel 1 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 18 Channel 2 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 19  Channel 3 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 20 Channel 4 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 21 Channel 5 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 22 Channel 6 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 23 Channel 7 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 24       

       

Fader 25 Channel 8 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 26 Channel 9 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 27  Channel 10 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 28 Channel 11 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 29 Channel 12 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 30 Channel 13 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 31 Channel 14 Aux 4 Send Levels Sends Mutes4 1-14     

Fader 32       
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SUBTRACTOR 
 

 
 
 
 

MAX49 
CONTROL 

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Filter Freq SubBank1  Fader 25 Noise Color SubBank1 

Fader 2 Filter Res SubBank1  Fader 26 Noise Level SubBank1 

Fader 3 Filter2 Freq SubBank1  Fader 27  Mod Env Gain SubBank1 

Fader 4 Filter2 Res SubBank1  Fader 28 Mod Env Dest SubBank1 

Fader 5 Filter Env Attack SubBank1  Fader 29 Mod Env Attack SubBank1 

Fader 6  Filter Env Decay SubBank1  Fader 30 Mod Env Decay SubBank1 

Fader 7 Filter Env Sustain SubBank1  Fader 31 Mod Env Sustain SubBank1 

Fader 8 Filter Env Release SubBank1  Fader 32 Mod Env Release SubBank1 

       

Fader 9 Osc1 Wave SubBank1  Fader 25 Ext Mod Select SubBank2 

Fader 10 Osc1 Octave SubBank1  Fader 26 Filter Freq Ext Mod SubBank2 

Fader 11 Osc1 Semitone SubBank1  Fader 27  LFO1 Ext Mod SubBank2 

Fader 12 Osc2 Wave SubBank1  Fader 28 Amp Ext Mod SubBank2 

Fader 13 Osc2 Octave SubBank1  Fader 29 FM Ext Mod SubBank2 

Fader 14 Osc2 Semitone SubBank1  Fader 30 Filter Freq Mod Wheel Amount SubBank2 

Fader 15 FM Amount SubBank1  Fader 31 Filter Res Mod Wheel Amount SubBank2 

Fader 16 Osc Mix SubBank1  Fader 32 LFO2 Kbd Track SubBank2 

       

Fader 17 Filter Type SubBank1  Switch 1 Filter Link Freq On/Off SubBank1 

Fader 18 Filter Kbd Track SubBank1  Switch 2 Filter2 On/Off SubBank1 

Fader 19  Filter Env Amount SubBank1  Switch 3 Filter Env Invert SubBank1 

Fader 20 Filter Env Vel Amount SubBank1  Switch 4 Mod Env Invert SubBank1 

Fader 21 Amp Env Attack SubBank1  Switch 5   

Fader 22 Amp Env Decay SubBank1  Switch 6    

Fader 23 Amp Env Sustain SubBank1  Switch 7   

Fader 24 Amp Env Release SubBank1  Switch 8   

       

Fader 17 LFO1 Rate SubBank2  Switch 9 Osc2 On/Off SubBank1 

Fader 18 LFO1 Amount SubBank2  Switch 10 Osc2 Kbd Track SubBank1 

Fader 19  LFO1 Wave SubBank2  Switch 11 Ring Mod SubBank1 

Fader 20 LFO1 Dest SubBank2  Switch 12 Noise On/Off SubBank1 

Fader 21 LFO2 Rate SubBank2  Switch 13   

Fader 22 LFO2 Amount SubBank2  Switch 14   

Fader 23 LFO2 Delay SubBank2  Switch 15   

Fader 24 LFO2 Dest SubBank2  Switch 16   
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THOR 
 

 

MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Filter 1 Freq   Fader 25 Mod Env Delay ThorBank1 

Fader 2 Filter 1 Res   Fader 26 Mod Env Attack ThorBank1 

Fader 3 Filter 2 Freq   Fader 27  Mod Env Decay ThorBank1 

Fader 4 Filter 2 Res   Fader 28 Mod Env Release ThorBank1 

Fader 5 Filter 3 Freq   Fader 29 Global Env Attack ThorBank1 

Fader 6  Filter 3 Res   Fader 30 Global Env Decay ThorBank1 

Fader 7 LFO 1 Rate   Fader 31 Global Env Sustain ThorBank1 

Fader 8 LFO 2 Rate   Fader 32 Global Env Release ThorBank1 

       

Fader 9 Filter Env Attack   Fader 25 Delay Time ThorBank2 

Fader 10 Filter Env Decay   Fader 26 Delay Feedback ThorBank2 

Fader 11 Filter Env Sustain   Fader 27  Delay Rate ThorBank2 

Fader 12 Filter Env Release   Fader 28 Delay Amt ThorBank2 

Fader 13 Amp Env Attack   Fader 29 Delay Dry Wet ThorBank2 

Fader 14 Amp Env Decay   Fader 30 Osc 1 And 2 Balance ThorBank2 

Fader 15 Amp Env Sustain   Fader 31 Shaper Drive ThorBank2 

Fader 16 Amp Env Release   Fader 32 Delay Time ThorBank2 

       

Fader 17 Filter 1 Env Amount ThorBank1   Switch 1 Osc 1 To Filter 1 Enable  

Fader 18 Filter 1 Drive ThorBank1  Switch 2 Osc 2 To Filter 1 Enable  

Fader 19  Filter 2 Env Amount ThorBank1  Switch 3 Osc 3 To Filter 1 Enable  

Fader 20 Filter 2 Drive ThorBank1  Switch 4 Osc 1 To Filter 2 Enable  

Fader 21 Filter 3 Global Env Amount ThorBank1  Switch 5 Osc 2 To Filter 2 Enable  

Fader 22 Filter 3 Drive ThorBank1  Switch 6  Osc 3 To Filter 2 Enable  

Fader 23 Rotary 1 ThorBank1  Switch 7   

Fader 24 Rotary 2 ThorBank1  Switch 8   

       

Fader 17 Osc 1 Mod ThorBank2  Switch 17 Osc 2 Sync To Osc 1  

Fader 18 Osc 2 Mod ThorBank2  Switch 18 Osc 3 Sync To Osc 1  

Fader 19  Osc 3 Mod ThorBank2  Switch 19 Delay On  

Fader 20 Osc 1 AM From Osc 2 ThorBank2  Switch 20 Delay Sync  

Fader 21 Osc 2 Sync BW ThorBank2  Switch 21 Shaper On  

Fader 22 Osc 3 Sync BW ThorBank2  Switch 22 Shaper Output Dest  

Fader 23 Osc 1 And 2 Level ThorBank2  Switch 23   

Fader 24 Osc 3 Level ThorBank2  Switch 24   
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MALSTRÖM 
 

 
 

MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Filter A Freq    Fader 25 Modulator A Curve MalBank2 

Fader 2 Filter A Resonance   Fader 26 Modulator A Target MalBank2 

Fader 3 Filter B Freq   Fader 27  Modulator B Curve MalBank2 

Fader 4 Filter B Resonance   Fader 28 Modulator B Target MalBank2 

Fader 5 Filter Env Attack   Fader 29 Modulator B To Modulator A MalBank2 

Fader 6  Filter Env Decay   Fader 30 Velocity To Level A MalBank2 

Fader 7 Filter Env Sustain   Fader 31 Velocity To Level B MalBank2 

Fader 8 Filter Env Release   Fader 32 Velocity To Filter Env MalBank2 

       

Fader 9 Oscillator A Attack   Switch 1 Filter A On/Off  

Fader 10 Oscillator A Decay   Switch 2 Filter A Env  

Fader 11 Oscillator A Sustain   Switch 3 Filter B On/Off  

Fader 12 Oscillator A Release   Switch 4 Filter B Env  

Fader 13 Oscillator B Attack   Switch 5 Filter Env Invert  

Fader 14 Oscillator B Decay   Switch 6  Shaper On/Off  

Fader 15 Oscillator B Sustain   Switch 7   

Fader 16 Oscillator B Release   Switch 8   

       

Fader 17 Filter Env Amount MalBank1  Switch 9 Oscillator A On/Off  

Fader 18 Filter A Mode MalBank1  Switch 10 Route Oscillator A To Shaper  

Fader 19  Filter B Mode MalBank1  Switch 11 Route Oscillator A To Filter B  

Fader 20 Shaper Mode MalBank1  Switch 12 Oscillator B On/Off  

Fader 21 Shaper Amount MalBank1  Switch 13 Route Oscillator B To Filter B  

Fader 22 Spread Amount MalBank1  Switch 14 Route Filter B To Shaper  

Fader 23 Portamento MalBank1  Switch 15   

Fader 24 Master Level MalBank1  Switch 16   

       

Fader 17 Modulator A Rate MalBank2  Switch 17 Modulator A On/Off  

Fader 18 Modulator A To Pitch MalBank2  Switch 18 Modulator A One Shot  

Fader 19  Modulator A To Index MalBank2  Switch 19 Modulator A Sync  

Fader 20 Modulator A To Shift MalBank2  Switch 20 Modulator B On/Off  

Fader 21 Modulator B Rate MalBank2  Switch 21 Modulator B One Shot  

Fader 22 Modulator B To Motion MalBank2  Switch 22 Modulator B Sync  

Fader 23 Modulator B To Level MalBank2  Switch 23   

Fader 24 Modulator B To Filter MalBank2  Switch 24   

       

Fader 25 Oscillator A Motion MalBank1     

Fader 26 Oscillator A Shift MalBank1     

Fader 27  Oscillator A Octave MalBank1     

Fader 28 Oscillator A Gain MalBank1     

Fader 29 Oscillator B Motion MalBank1     

Fader 30 Oscillator B Shift MalBank1     

Fader 31 Oscillator B Octave MalBank1     

Fader 32 Oscillator B Gain MalBank1     
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NN19 SAMPLER 
 

 
 
 
 

MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Filter Freq   Fader 25 LFO Rate NN19Bank1 

Fader 2 Filter Res   Fader 26 LFO Amount NN19Bank1 

Fader 3 Filter Kbd Track   Fader 27  LFO Wave NN19Bank1 

Fader 4 Filter Env Amount   Fader 28 LFO Dest NN19Bank1 

Fader 5 Filter Env Attack   Fader 29   

Fader 6  Filter Env Decay   Fader 30   

Fader 7 Filter Env Sustain   Fader 31   

Fader 8 Filter Env Release   Fader 32   

       

Fader 9 Osc Octave   Fader 25 Filter Freq Mod Wheel Amount NN19Bank2 

Fader 10 Osc Semitone   Fader 26 Filter Res Mod Wheel Amount NN19Bank2 

Fader 11 Osc Fine Tune   Fader 27  Filter Decay Mod Wheel Amount NN19Bank2 

Fader 12 Osc Env Amount   Fader 28 Amp Mod Wheel Amount NN19Bank2 

Fader 13 Sample Start   Fader 29 LFO Mod Wheel Amount NN19Bank2 

Fader 14    Fader 30   

Fader 15    Fader 31   

Fader 16 Master Level   Fader 32   

       

Fader 17 Filter Mode NN19Bank1  Switch 1 Filter On/Off  

Fader 18 Filter Freq Ext Mod NN19Bank1  Switch 2 Filter Env Invert  

Fader 19  LFO Ext Mod NN19Bank1  Switch 3 Sample  

Fader 20 Amp Ext Mod NN19Bank1  Switch 4   

Fader 21 Amp Env Attack NN19Bank1  Switch 5   

Fader 22 Amp Env Decay NN19Bank1  Switch 6    

Fader 23 Amp Env Sustain NN19Bank1  Switch 7   

Fader 24 Amp Env Release NN19Bank1  Switch 8   

       

Fader 17 Filter Env Vel Amount NN19Bank2  Switch 9 Osc Kbd Track  

Fader 18 Filter Decay Vel Amount NN19Bank2  Switch 10 LFO Sync Enable  

Fader 19  Amp Vel Amount NN19Bank2  Switch 11 High Quality Interpolation  

Fader 20 Amp Attack Vel Amount NN19Bank2  Switch 12 Low Bandwidth On/Off  

Fader 21 Sample Start Vel Amount NN19Bank2  Switch 13   

Fader 22 Portamento NN19Bank2  Switch 14   

Fader 23 Polyphony NN19Bank2  Switch 15   

Fader 24 Stereo Spread NN19Bank2  Switch 16   
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NN-XT ADVANCED SAMPLER 
 

MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Filter Freq   Fader 17 Drum 9 Pitch Level Pan 9-10 

Fader 2 Filter Res   Fader 18 Drum 10 Pitch Level Pan 9-10 

Fader 3 Amp Env Attack   Fader 19    

Fader 4 Amp Env Decay   Fader 20   

Fader 5 Amp Env Release   Fader 21   

Fader 6  Mod Env Decay   Fader 22   

Fader 7 Master Volume   Fader 23   

Fader 8    Fader 24   

       

Fader 1 Drum 1 Level Level Pan 1-8  Fader 25 Drum 1 Send 1 Amount Level Pan 1-8 

Fader 2 Drum 2 Level Level Pan 1-8  Fader 26 Drum 2 Send 1 Amount Level Pan 1-8 

Fader 3 Drum 3 Level Level Pan 1-8  Fader 27  Drum 3 Send 1 Amount Level Pan 1-8 

Fader 4 Drum 4 Level Level Pan 1-8  Fader 28 Drum 4 Send 1 Amount Level Pan 1-8 

Fader 5 Drum 5 Level Level Pan 1-8  Fader 29 Drum 5 Send 1 Amount Level Pan 1-8 

Fader 6  Drum 6 Level Level Pan 1-8  Fader 30 Drum 6 Send 1 Amount Level Pan 1-8 

Fader 7 Drum 7 Level Level Pan 1-8  Fader 31 Drum 7 Send 1 Amount Level Pan 1-8 

Fader 8 Drum 8 Level Level Pan 1-8  Fader 32 Drum 8 Send 1 Amount Level Pan 1-8 

       

Fader 1 Drum 9 Level Level Pan 9-10  Fader 25 Drum 9 Send 1 Amount Level Pan 9-10 

Fader 2 Drum 10 Level Level Pan 9-10  Fader 26 Drum 10 Send 1 Amount Level Pan 9-10 

Fader 3    Fader 27    

Fader 4    Fader 28   

Fader 5    Fader 29   

Fader 6     Fader 30   

Fader 7    Fader 31   

Fader 8    Fader 32   

       

Fader 9 Drum 1 Pan Level Pan 1-8  Switch 1   

Fader 10 Drum 2 Pan Level Pan 1-8  Switch 2   

Fader 11 Drum 3 Pan Level Pan 1-8  Switch 3 Sample  

Fader 12 Drum 4 Pan Level Pan 1-8  Switch 4   

Fader 13 Drum 5 Pan Level Pan 1-8  Switch 5   

Fader 14 Drum 6 Pan Level Pan 1-8  Switch 6    

Fader 15 Drum 7 Pan Level Pan 1-8  Switch 7   

Fader 16 Drum 8 Pan Level Pan 1-8  Switch 8   

       

Fader 9 Drum 9 Pan Level Pan 9-10  Pad 1 Bank A  

Fader 10 Drum 10 Pan Level Pan 9-10  Pad 2 Bank B  

Fader 11    Pad 3 Bank C  

Fader 12    Pad 4 Bank D  

Fader 13    Pad 5 Pattern 5  

Fader 14    Pad 6 Pattern 6  

Fader 15    Pad 7 Pattern 7  

Fader 16    Pad 8 Pattern 8  

    Pad 9 Pattern 1  

Fader 17 Drum 1 Pitch Level Pan 1-8  Pad 10 Pattern 2  

Fader 18 Drum 2 Pitch Level Pan 1-8  Pad 11 Pattern 3  

Fader 19  Drum 3 Pitch Level Pan 1-8  Pad 12 Pattern 4  

Fader 20 Drum 4 Pitch Level Pan 1-8     

Fader 21 Drum 5 Pitch Level Pan 1-8     

Fader 22 Drum 6 Pitch Level Pan 1-8     

Fader 23 Drum 7 Pitch Level Pan 1-8     

Fader 24 Drum 8 Pitch Level Pan 1-8     



18 

 

KONG DRUM DESIGNER 
 

 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Drum 1 Level  Fader 25 Drum 9 Bus FX Send 

Fader 2 Drum 2 Level  Fader 26 Drum 10 Bus FX Send 

Fader 3 Drum 3 Level  Fader 27  Drum 11 Bus FX Send 

Fader 4 Drum 4 Level  Fader 28 Drum 12 Bus FX Send 

Fader 5 Drum 5 Level  Fader 29 Drum 13 Bus FX Send 

Fader 6  Drum 6 Level  Fader 30 Drum 14 Bus FX Send 

Fader 7 Drum 7 Level  Fader 31 Drum 15 Bus FX Send 

Fader 8 Drum 8 Level  Fader 32 Drum 16 Bus FX Send 

     

Fader 9 Drum 9 Level  Switch 1  

Fader 10 Drum 10 Level  Switch 2  

Fader 11 Drum 11 Level  Switch 3 Quick Sample 

Fader 12 Drum 12 Level  Switch 4  

Fader 13 Drum 13 Level  Switch 5 Select Previous Patch 

Fader 14 Drum 14 Level  Switch 6  Select Next Patch 

Fader 15 Drum 15 Level  Switch 7  

Fader 16 Drum 16 Level  Switch 8  

     

Fader 17 Drum 1 Bus FX Send    

Fader 18 Drum 2 Bus FX Send    

Fader 19  Drum 3 Bus FX Send    

Fader 20 Drum 4 Bus FX Send    

Fader 21 Drum 5 Bus FX Send    

Fader 22 Drum 6 Bus FX Send    

Fader 23 Drum 7 Bus FX Send    

Fader 24 Drum 8 Bus FX Send    
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RV7000 ADVANCED REVERB 
 

 

SCREAM 4 DISTORTION 
 

 
 

MAX49 CONTROL REASON  FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Decay  Switch 1 EQ On/Off 

Fader 2 HF Damp  Switch 2 Gate On/Off 

Fader 3 Hi EQ  Switch 3  

Fader 4 Dry/Wet  Switch 4  

Fader 5   Switch 5  

Fader 6    Switch 6   

Fader 7   Switch 7  

Fader 8   Switch 8  

     

Fader 9 Soft Knob 1    

Fader 10 Soft Knob 2    

Fader 11 Soft Knob 3    

Fader 12 Soft Knob 4    

Fader 13 Soft Knob 5    

Fader 14 Soft Knob 6    

Fader 15 Soft Knob 7    

Fader 16 Soft Knob 8    

MAX49 CONTROL REASON  FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Damage Control  Switch 1 Damage On/Off 

Fader 2 Damage Type  Switch 2 Cut On/Off 

Fader 3 Parameter 1  Switch 3 Body On/Off 

Fader 4 Parameter 2  Switch 4  

Fader 5 Cut Lo  Switch 5  

Fader 6  Cut Mid  Switch 6   

Fader 7 Cut Hi  Switch 7  

Fader 8 Master Level  Switch 8  

     

Fader 9 Body Resonance    

Fader 10 Body Scale    

Fader 11 Body Auto    

Fader 12 Body Type    

Fader 13     

Fader 14     

Fader 15     

Fader 16     
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BV512 DIGITAL VOCODER 
 

 

NEPTUNE PITCH ADJUSTER 
 

 
 

MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

Fader 25 Band Count   Switch 1 Vocoder/Equalizer  

Fader 26 Shift   Switch 2 Hold  

Fader 27  Attack   Switch 3   

Fader 28 Decay   Switch 4   

Fader 29 HF Emphasis   Switch 5   

Fader 30 Dry/Wet   Switch 6    

Fader 31    Switch 7   

Fader 32    Switch 8   

       

Fader 1 Band Level 1 Band   Fader 17 Band Level 17 Band  

Fader 2 Band Level 2 Band   Fader 18 Band Level 18 Band  

Fader 3 Band Level 3 Band   Fader 19  Band Level 19 Band  

Fader 4 Band Level 4 Band   Fader 20 Band Level 20 Band  

Fader 5 Band Level 5 Band   Fader 21 Band Level 21 Band  

Fader 6  Band Level 6 Band   Fader 22 Band Level 22 Band  

Fader 7 Band Level 7  Band   Fader 23 Band Level 23 Band  

Fader 8 Band Level 8  Band   Fader 24 Band Level 24 Band  

       

Fader 9 Band Level 9 Band   Fader 25 Band Level 25 Band 

Fader 10 Band Level 10 Band   Fader 26 Band Level 26 Band 

Fader 11 Band Level 11 Band   Fader 27  Band Level 27 Band 

Fader 12 Band Level 12 Band   Fader 28 Band Level 28 Band 

Fader 13 Band Level 13 Band   Fader 29 Band Level 29 Band 

Fader 14 Band Level 14 Band   Fader 30 Band Level 30 Band 

Fader 15 Band Level 15 Band   Fader 31 Band Level 31 Band 

Fader 16 Band Level 16 Band   Fader 32 Band Level 32 Band 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Switch 1 Pitch Adjust On/Off  Fader 1 Correction Speed 

Switch 2 Scale Memory  Fader 2 Preserve Expression 

Switch 3 Transpose On/Off  Fader 3 Semitones 

Switch 4 MIDI Destination  Fader 4 Cent 

Switch 5 Formant On/Off  Fader 5 Formant Shift 

Switch 6  Enabled  Fader 6  Vibrato Rate 

Switch 7   Fader 7 Pitch Bend Range 

Switch 8   Fader 8  

   Fader 9 Pitched Signal Level 

   Fader 10 Voice Synth Level 
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MCLASS EQUALIZER 
 

 

MCLASS STEREO IMAGER 
 

 

MCLASS COMPRESSOR 
 

 

MCLASS MAXIMIZER 
 

 

RV-7 DIGITAL REVERB 
 

 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Low Shelf Gain  Switch 1 Low Cut Enable 

Fader 2 Parametric 1 Gain  Switch 2 Low Shelf Enable 

Fader 3 Parametric 2 Gain  Switch 3 Parametric 1 Enable 

Fader 4 Hi Shelf Gain  Switch 4 Parametric 2 Enable 

Fader 5 Low Shelf Q  Switch 5 Hi Shelf Enable 

Fader 6  Parametric 1 Q    

Fader 7 Parametric 2 Q    

Fader 8 Hi Shelf Q    

Fader 9 Low Shelf Frequency    

Fader 10 Parametric 1 Frequency    

Fader 11 Parametric 2 Frequency    

Fader 12 Hi Shelf Frequency    

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Low Width  Switch 1 Low Band Active 

Fader 2 X-Over Frequency  Switch 2 High Band Active 

Fader 3 High Width  Switch 3 Separate Out Mode 

Fader 4 Solo Mode    

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Input Gain  Switch 1 Soft Knee 

Fader 2 Threshold  Switch 2 Sidechain Solo 

Fader 3 Ratio  Switch 3 Adapt 

Fader 4 Attack  Switch 4 Sidechain Active 

Fader 5 Release    

Fader 6  Output Gain    

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Input Gain  Switch 1 Limiter Enable 

Fader 2 Attack Speed  Switch 2 Look Ahead Enable 

Fader 3 Release Speed  Switch 3 Soft Clip Enable 

Fader 4 Output Gain  Switch 4 Output Level Meter Mode 

Fader 5 Soft Clip Amount    

MAX49 CONTROL REASON FUNCTION    
Fader 1 Algorithm    

Fader 2 Size    

Fader 3 Decay    

Fader 4 Damping    

Fader 5 Dry/Wet    
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DDL-1 DIGITAL DELAY LINE 
 

 

D-11 FOLDBACK DISTORTION 
 

 

ECF-42 ENVELOPE CONTROLLER FILTER 
 

 

CF-101 CHORUS/FLANGER 
 

 

PH-90 PHASER 
 

 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 DelayTime (steps)  Switch 1 Unit 

Fader 2 DelayTime (ms)  Switch 2 Step Length 

Fader 3 Feedback    

Fader 4 Pan    

Fader 5 Dry/Wet Balance    

MAX49 CONTROL REASON FUNCTION    
Fader 1 Amount    

Fader 2 Foldback    

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Frequency  Switch 1 Trigger 

Fader 2 Resonance    

Fader 3 Env Amount    

Fader 4 Velocity    

Fader 5 Mode    

Fader 6      

Fader 7     

Fader 8     

Fader 9 Attack    

Fader 10 Decay    

Fader 11 Sustain    

Fader 12 Release    

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Delay  Switch 1 LFO Sync Enable 

Fader 2 Feedback  Switch 2 Send/Insert Mode 

Fader 3 Rate    

Fader 4 Modulation Amount    

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Frequency  Switch 1 LFO Sync Enable 

Fader 2 Split    

Fader 3 Width    

Fader 4 Rate    

Fader 5 Frequency Modulation    

Fader 6  Feedback    
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UN-16 UNISON 
 

 

COMP-01 COMPRESSOR/LIMITER 
 

 

PEQ-2 TWO-BAND PARAMETRIC EQ 
 

 

MATRIX PATTERN SEQUENCER 
 

MAX49 CONTROL REASON FUNCTION    
Fader 1 Voice Count    

Fader 2 Detune    

Fader 3 Dry/Wet    

MAX49 CONTROL REASON FUNCTION    
Fader 1 Ratio    

Fader 2 Threshold    

Fader 3 Attack    

Fader 4 Release    

Fader 5     

Fader 6  Gain    

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Filter A Freq  Switch 1 Filter B On/Off 

Fader 2 Filter A Q    

Fader 3 Filter A Gain    

Fader 4 Filter B Freq    

Fader 5 Filter B Q    

Fader 6  Filter B Gain    

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Pad 1 Bank A  Fader 1 Pattern Select in Bank 

Pad 2 Bank B  Fader 2 Bank Select 

Pad 3 Bank C  Fader 3 Resolution 

Pad 4 Bank D    

Pad 5 Pattern 5  Switch 1 Run 

Pad 6 Pattern 6  Switch 2 Pattern Enable 

Pad 7 Pattern 7    

Pad 8 Pattern 8    

Pad 9 Pattern 1    

Pad 10 Pattern 2    

Pad 11 Pattern 3    

Pad 12 Pattern 4    
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RPG-8 MONOPHONIC ARPEGGIATOR 
 

 

REGROOVE MIXER 
 

 

ID8 INSTRUMENT DEVICE 
 

 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Switch 1 Hold  Switch 17 Pattern Step 7 

Switch 2 Arpeggiator Enable  Switch 18 Pattern Step 8 

Switch 3 Single Note Repeat  Switch 19 Pattern Step 9 

Switch 4 Shuffle  Switch 20 Pattern Step 10 

Switch 5 Pattern Enable  Switch 21 Pattern Step 11 

Switch 6  Sync  Switch 22 Pattern Step 12 

Switch 7   Switch 23  

Switch 8   Switch 24  

     

Switch 9 Pattern Step 1  Fader 1 Velocity/Manual 

Switch 10 Pattern Step 2  Fader 2 Mode 

Switch 11 Pattern Step 3  Fader 3 Octave 

Switch 12 Pattern Step 4  Fader 4 Insert 

Switch 13 Pattern Step 5  Fader 5 Rate 

Switch 14 Pattern Step 6  Fader 6 Gate Length 

Switch 15   Fader 7  

Switch 16   Fader 8  

MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL 

REASON  
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 A1 Groove Amount   Fader 9 A1 Slide Slide 

Fader 2 A2 Groove Amount   Fader 10 A2 Slide Slide 

Fader 3 A3 Groove Amount   Fader 11 A3 Slide Slide 

Fader 4 A4 Groove Amount   Fader 12 A4 Slide Slide 

Fader 5 A5 Groove Amount   Fader 13 A5 Slide Slide 

Fader 6  A6 Groove Amount   Fader 14 A6 Slide Slide 

Fader 7 A7 Groove Amount   Fader 15 A7 Slide Slide 

Fader 8 A8 Groove Amount   Fader 16 A8 Slide Slide 

       

Fader 9 A1 Shuffle Shuffle     

Fader 10 A2 Shuffle Shuffle     

Fader 11 A3 Shuffle Shuffle     

Fader 12 A4 Shuffle Shuffle     

Fader 13 A5 Shuffle Shuffle     

Fader 14 A6 Shuffle Shuffle     

Fader 15 A7 Shuffle Shuffle     

Fader 16 A8 Shuffle Shuffle     

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Parameter 1  Switch 1  

Fader 2 Parameter 2  Switch 2  

Fader 3   Switch 3  

Fader 4   Switch 4  

Fader 5   Switch 5  

Fader 6    Switch 6   

Fader 7   Switch 7 Select Previous Preset 

Fader 8 Volume  Switch 8 Select Next Preset 
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LINE6 GUITAR AMP 
 

 

LINE6 BASS AMP 
 

 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Volume Pedal  Switch 1 Wah Pedal On 

Fader 2 Drive  Switch 2  

Fader 3 Bass  Switch 3 Select Previous Amp Model 

Fader 4 Middle  Switch 4 Select Next Amp Model 

Fader 5 Treble  Switch 5 Select Previous Cab Model 

Fader 6  Presence  Switch 6  Select Next Cab Model 

Fader 7   Switch 7  

Fader 8 Volume  Switch 8  

     

Expression Wah Pedal  Switch 9  

   Switch 10  

   Switch 11  

   Switch 12  

   Switch 13  

   Switch 14  

   Switch 15 Select Previous Patch 

   Switch 16 Select Next Patch 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Comp Threshold  Switch 1 Compressor On 

Fader 2 Drive  Switch 2  

Fader 3 Bass  Switch 3 Select Previous Amp Model 

Fader 4 Lo Mid  Switch 4 Select Next Amp Model 

Fader 5 Hi Mid  Switch 5 Select Previous Cab Model 

Fader 6  Treble  Switch 6  Select Next Cab Model 

Fader 7   Switch 7  

Fader 8 Volume  Switch 8  

     

   Switch 9  

   Switch 10  

   Switch 11  

   Switch 12  

   Switch 13  

   Switch 14  

   Switch 15 Select Previous Patch 

   Switch 16 Select Next Patch 
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REASON RECORD MAIN MIXER CHANNEL 
 

 

MAX49 
CONTROL 

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Level   Fader 25 HF Gain   

Fader 2 Pan   Fader 26 HF Frequency  

Fader 3 Width   Fader 27    

Fader 4    Fader 28   

Fader 5 Rotary 1   Fader 29 LPF On  

Fader 6  Rotary 2   Fader 30 LPF Frequency  

Fader 7 Rotary 3   Fader 31 HPF On  

Fader 8 Rotary 4   Fader 32 HPF Frequency   

       

Fader 9 FX1 Send Level   Switch 1 Mute  

Fader 10 FX2 Send Level   Switch 2 Solo  

Fader 11 FX3 Send Level   Switch 3 Switch 1  

Fader 12 FX4 Send Level   Switch 4 Switch 2  

Fader 13 FX5 Send Level   Switch 5 Switch 3  

Fader 14 FX6 Send Level   Switch 6  Switch 4  

Fader 15 FX7 Send Level   Switch 7   

Fader 16 FX8 Send Level   Switch 8   

       

Fader 17 LF Gain Equalizer   Switch 9 FX1 Send On  

Fader 18 LF Frequency Equalizer  Switch 10 FX2 Send On  

Fader 19  LMF Gain Equalizer  Switch 11 FX3 Send On  

Fader 20 LMF Frequency Equalizer  Switch 12 FX4 Send On  

Fader 21 LMF Q Equalizer  Switch 13 FX5 Send On  

Fader 22 HMF Gain Equalizer  Switch 14 FX6 Send On  

Fader 23 HMF Frequency Equalizer  Switch 15 FX7 Send On  

Fader 24 HMF Q Equalizer  Switch 16 FX8 Send On  

       

Fader 17 Input Gain Compressor  Switch 17 EQ On  

Fader 18 Invert Phase  Compressor  Switch 18 EQ E Mode  

Fader 19  Comp On  Compressor  Switch 19 LF Bell  

Fader 20 C Ratio  Compressor  Switch 20 HF Bell  

Fader 21 C Threshold  Compressor  Switch 21   

Fader 22 C Release  Compressor  Switch 22   

Fader 23    Switch 23   

Fader 24    Switch 24   
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REASON RECORD MASTER SECTION 
 

 

MAX49 
CONTROL 

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

 MAX49 
CONTROL

REASON 
FUNCTION 

CONTROL 
VARIATIONS 

Fader 1 Channel 1 Level   Fader 25 Compressor On FX 
Fader 2 Channel 2 Level   Fader 26 Threshold  FX 
Fader 3 Channel 3 Level   Fader 27  Ratio  FX 
Fader 4 Channel 4 Level   Fader 28   

Fader 5 Channel 5 Level   Fader 29 Attack  FX 
Fader 6  Channel 6 Level   Fader 30 Release  FX 
Fader 7 Channel 7 Level   Fader 31 Make-Up Gain  FX 
Fader 8 Channel 8 Level   Fader 32   

       

Fader 9 Channel 1 Pan Main  Switch 1 Previous 8 Remote 
Base Channel 

 

Fader 10 Channel 2 Pan  Main  Switch 2 Next 8 Remote Base 
Channel 

 

Fader 11 Channel 3 Pan  Main  Switch 3   

Fader 12 Channel 4 Pan  Main  Switch 4   

Fader 13 Channel 5 Pan  Main  Switch 5   

Fader 14 Channel 6 Pan  Main  Switch 6    

Fader 15 Channel 7 Pan  Main  Switch 7   

Fader 16 Channel 8 Pan  Main  Switch 8 Bypass Insert FX  

       

Fader 9 FX1 Pan FX  Switch 9   

Fader 10 FX2 Pan  FX  Switch 10   

Fader 11 FX3 Pan  FX  Switch 11   

Fader 12 FX4 Pan  FX  Switch 12   

Fader 13 FX5 Pan  FX  Switch 13   

Fader 14 FX6 Pan  FX  Switch 14   

Fader 15 FX7 Pan  FX  Switch 15   

Fader 16 FX8 Pan  FX  Switch 16   

       

Fader 17 FX1 Return Level   Switch 17 FX1 Mute  

Fader 18 FX2 Return Level   Switch 18 FX2 Mute  

Fader 19  FX3 Return Level   Switch 19 FX3 Mute  

Fader 20 FX4 Return Level   Switch 20 FX4 Mute  

Fader 21 FX5 Return Level   Switch 21 FX5 Mute  

Fader 22 FX6 Return Level   Switch 22 FX6 Mute  

Fader 23 FX7 Return Level   Switch 23 FX7 Mute  

Fader 24 FX8 Return Level   Switch 24 FX8 Mute  

       

Fader 25 Rotary 1  Main  Switch 25 Switch 1  

Fader 26 Rotary 2  Main  Switch 26 Switch 2  

Fader 27  Rotary 3  Main  Switch 27 Switch 3  

Fader 28 Rotary 4  Main  Switch 28 Switch 4  

Fader 29    Switch 29   

Fader 30    Switch 30   

Fader 31    Switch 31   

Fader 32 Master Level Main  Switch 32   
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REASON RECORD GLOBAL CONTROLS 
 

 

REASON ESSENTIALS MAIN MIXER CHANNEL 
 

 
 
 
 
 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Stop Stop  Switch 15 Select Prev Patch for Target Device 

Play Play  Switch 16 Select Next Patch for Target Device 

Record Record  Switch 7 Target Previous Track 

Rewind Rewind  Switch 8 Target Next Track 

Fast Forward Fast Forward  Switch 23 Select Previous Keyboard Shortcut Variation 

Stop Stop  Switch 24 Select Next Keyboard Shortcut Variation 

MAX49 CONTROL REASON FUNCTION  MAX49 CONTROL REASON FUNCTION 
Fader 1 Level  Switch 1 Mute 

Fader 2 Pan  Switch 2 Solo 

Fader 3 Width  Switch 3 Switch 1 

Fader 4   Switch 4 Switch 2 

Fader 5 Rotary 1  Switch 5 Switch 3 

Fader 6  Rotary 2  Switch 6  Switch 4 

Fader 7 Rotary 3  Switch 7  
Fader 8 Rotary 4  Switch 8  
     
Fader 9 Input Gain  Switch 9  
Fader 10 Invert Phase  Switch 10  
Fader 11 LF Gain  Switch 11 EQ On 

Fader 12 LF Frequency  Switch 12 LF Bell 

Fader 13 HF Gain  Switch 13 HF Bell 

Fader 14 HF Frequency  Switch 14  
Fader 15   Switch 15  
Fader 16   Switch 16  
     
Fader 17 FX1 Send Level  Switch 17 FX1 Send On 

Fader 18 FX2 Send Level  Switch 18 FX2 Send On 

Fader 19  FX3 Send Level  Switch 19  FX3 Send On 

Fader 20 FX4 Send Level  Switch 20 FX4 Send On 

Fader 21   Switch 21 FX1 Pre Fader 

Fader 22   Switch 22 FX2 Pre Fader 

Fader 23   Switch 23 FX3 Pre Fader 

Fader 24   Switch 24 FX4 Pre Fader 
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Steinberg Cubase 
 

Setup 
 
1. Connect MAX49 to your computer with the included USB cable. Open Cubase. 
2. On MAX49, select the Cubase or CubaseKS Program. Press the VALUE DIAL to load it. 

Note: If you have edited MAX49's Programs and are unable to load the Program, use the supplied Vyzex editor to 
load the Factory Preset Bank and "PUT" or download the factory preset bank into MAX49. 

3. In Cubase, click Devices in the menu bar, and select Device Setup.  
4. In the Device Setup window's upper left corner, click the + symbol, and select Mackie Control. 
5. In the upper right part of the window, click each drop-down menu next to MIDI Input and MIDI Output, and select 

MIDIIN4 (Akai MAX49) (Windows 7/Vista) or USB Audio Device [4] (Windows XP). 
6. Click OK.  
 
IMPORTANT!: To use MAX49's TRANSPORT CONTROLS (Play, Stop, Record, etc.) in Cubase, follow these additional 
steps: 
1. Press [EDIT] on MAX49. 
2. Press any one of MAX49's TRANSPORT CONTROLS. 
3. Turn the VALUE DIAL until the Type is set to Mackie. You may now use the TRANSPORT CONTROLS in Cubase. 
 

Cubase 
 
When using MAX49's Cubase Program, the controls' behavior is as follows: 
 
TRANSPORT CONTROLS (Play, Stop, Rec, etc.): When these controls are set to Mackie, they will work accordingly in 
the software. See the note in the Setup section above. 
 
BANK 1-8:  

TOUCH FADERS: These control the volume level of Tracks 1-8.  
S-SWITCHES: These mute Tracks 1-8. 

 
BANK 9-16:  

TOUCH FADERS: These control the panning of Tracks 1-8. 
S-SWITCHES: These "solo" Tracks 1-8. 

 
BANK 17-24:  

TOUCH FADERS: These control the panning of Tracks 1-8. 
S-SWITCHES: These record-arm Tracks 1-8. 

 
BANK 25-32:  

TOUCH FADERS: These control the panning of Tracks 1-8. 
S-SWITCHES: These select Tracks 1-8. 

 

CubaseKS 
 
This Program is almost the same as the Cubase Program described above, but this version allows you to turn MAX49's 
Sequencer on/off by pressing keys on its KEYBOARD. To do this: 
 
1. Press SEQ SELECT so it is lit. 
2. Press ON/OFF so it is lit. 
3. Press and hold a key on MAX49's KEYBOARD. The Sequence will play (in that key) while the key is being held. 

When you release the key, the Sequence will stop.  
Note: (To "latch" the Sequencer, press [LATCH] so it is lit. When this button is activated, Sequencer playback will 
continue even after the key is released.) 
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Apple Logic Pro 
 

Setup 
 
You can use MAX49 with Logic Pro 8 or higher. MAX49's Mackie Control protocol allows it to act as a control surface for 
the DAW. To do this: 
 
1. Connect MAX49 to your computer with the included USB cable. Open Logic Pro. 

2. On MAX49, select the Mackie Control Program. Press the VALUE DIAL to load it. 

3. In Logic Pro, click the Logic Pro menu, then select Preferences  MIDI. 

4. In the window that appears, select the Control Surfaces page, and click Setup in the lower right corner. 

5. In the window that appears, click New, and select Install. 

6. From the list that appears, select the device that lists Mackie Designs as the Manufacturer and Mackie Control as 
the Model. 

7. Click Add in the lower right corner of the window, then close the window. Do not click Scan. 

8. Select Mackie as the Out Port and Input. 

9. Close all the Preferences window. 
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Image-Line FL Studio 
 

Setup 
 
1. Download the FL Studio controller map to your computer from the included CD or from www.akaipro.com/max49. 
 
2. With FL Studio closed, copy the entire MAX49 folder (the folder itself, not just its contents) to the following location in 

your computer: C:\Program Files\Image-Line\FL Studio 8\Data\Projects\Templates\Hardware. 
 
3. Connect MAX49 to your computer with the included USB cable. Open FL Studio. 
 
4. On MAX49, select the FLStudio or FLStudKS Program. Press the VALUE DIAL to load it. 

Note: If you have edited MAX49's Programs and are unable to load the Program, use the supplied Vyzex editor to 
load the Factory Preset Bank and "PUT" or download the factory preset bank into MAX49. 

 
5. Press F10, or go to Options  MIDI Settings. 
 
6. Under Output, select MAX49 (Windows 7/Vista) or USB Audio Device (Windows XP), and check the Send master 

sync box. 
 
7. Under Input, select MAX49 (Windows 7/Vista) or USB Audio Device (Windows XP), and check the Enable box. 
 
8. For Omni preview MIDI channel, select Channel 16. 
 
9. For Generator muting MIDI channel, select Channel 15. 
 
10. Check the Record to step sequencer box. 
 
MAX49's FL Studio Program is configured to use FL Studio's step sequencer. For working with the Piano Roll, use one of 
the Akai MPK's generic templates. 
 

FLStudio 
 
MAX49's FL Studio Program has a sampler channel dedicated to each pad: 

• Pad Bank A: Plays each channel at its true pitch. 

• Pad Bank B: Mutes the corresponding PAD. 

• Pad Bank C: Selects the corresponding channel, allowing for each channel to be played chromatically with 
MAX49's KEYBOARD. 

• Pad Bank D: Plays the sample loaded on the selected track in semitones. 
 
MAX49's S-SWITCHES will select additional tracks beyond the first 12, allowing for easy selection of generators, VST 
plug-in channels, etc. 
 

FLStudKS 
 
This Program is almost the same as the FL Studio Program described above, but this version allows you to turn MAX49's 
Sequencer on/off by pressing keys on its KEYBOARD. To do this: 
 
1. Press SEQ SELECT so it is lit. 

2. Press ON/OFF so it is lit. 

3. Press and hold a key on MAX49's KEYBOARD. The Sequence will play (in that key) while the key is being held. 
When you release the key, the Sequence will stop.  

Note: (To "latch" the Sequencer, press [LATCH] so it is lit. When this button is activated, Sequencer playback will 
continue even after the key is released.) 

 



32 

 

FXpansion GURU 
 
FXpansion's GURU software is a very flexible and creative beat-making tool. GURU comes preset with default MIDI note and controller 
note mappings that serve several purposes. Notes can be set to trigger sounds, map a sound chromatically and play it from a keyboard, 
trigger different Patterns, and trigger different Scenes. 
 
8 MIDI controllers are set up for use with the individual voice engines called "Pad Groups," and 8 more are set up for use with any of 
the FX Group. Please see the GURU manual for information on assigning these functions to the different parameters. 
 
MAX49's GURU preset lets you take advantage of the software's most-used functions. This preset is meant to be used with GURU's 
Generic Controller map in the Options menu. 
 

FX Guru 
 
KEYBOARD: The keyboard is set to trigger pads from middle C up 16 notes. The default is set to control Engine 1 on MIDI Channel 1. 
By editing the keyboard MIDI channel, you can select which voice engine you are controlling. We set middle C to be the pads so that if 
you have Pattern keys play selected pad chromatically in the Options/MIDI page, you will hear the currently selected pad played 
chromatically on the bottom two octaves of MAX49's keyboard. If you press the OCTAVE UP button twice, the drum pads will play on 
the lowest 16 notes of the keyboard and the notes from middle C up will trigger different Scenes. 
 
TRANSPORT CONTROLS: GURU makes use of MMC for its transport controls. If you have the latest version of GURU it will 
automatically make use of MMC messages. GURU assigns the  button to the Commit function and the  button to the Undo 
function. 
 
MIDI Controllers: We created 4 different options for continuous controller mapping with GURU. Since the MIDI controllers are color-
coded in the software, we will call them as follows: 
 
Red = 1 

Orange = 2 

Yellow = 3 

Green = 4 

Lt Blue = 5  

Blue = 6 

Purple = 7  

Grey = 8 

Controller Bank 1–8  

• TOUCH FADERS 1–8: FX Group 1–8 

• S-SWITCHES 1–4: Pad Group 5–8 

• S-SWITCHES 5–8: FX Group 5–8 

 

Controller Bank 9–16 

• TOUCH FADERS 1–8: Pad Group 1–8 (reversed from 
Controller Bank A) 

• S-SWITCHES 1–4: Pad Group 5–8 

• S-SWITCHES 5–8: FX Group 5–8 

Controller Bank 17–24 

• TOUCH FADERS 1–4: Pad Group 1–4 

• TOUCH FADERS 5–8: FX Group 5–8 

• S-SWITCHES 1–4: Pad Group 5–8 

• S-SWITCHES 5–8: FX Group 5–8 

 

Controller Bank 25–32 

• TOUCH FADERS 1–4: Pad Group 1–4 

• TOUCH FADERS 5–8: FX Group 1–4 

 
PADS: We intentionally mapped the pads to be chromatic. The pads can be customized for so many uses in GURU that we didn't want 
to make them too specialized. Currently, the 12 pads in Bank A and Pads 1-4 in Bank B will normally play the GURU pads. We left 
these set to the Common MIDI channel so that you could quickly change them to different voice engines by changing the Common 
Channel in Global Mode (see the GLOBAL MODE section of the included MAX49 Quickstart Guide).  

Depending on how you are using GURU, if you want to change the pad note and channel mappings, keep this in mind: 

• Recording Patterns: You may want to leave the way they are, allowing you to play your drum sounds and to shift engines via 
changing the Common Channel.  

• Playing Live: You may want to assign the pads to different MIDI channels and notes so as to trigger Scenes or Patterns in a 
real-time DJ style work flow.  

 

FXGuruKS 
 
This Program is almost the same as the GURU Program described above, but this version allows you to turn MAX49's Sequencer 
on/off by pressing keys on its KEYBOARD. To do this: 
 
1. Press SEQ SELECT so it is lit. 

2. Press ON/OFF so it is lit. 

3. Press and hold a key on MAX49's KEYBOARD. The Sequence will play (in that key) while the key is being held. When you release 
the key, the Sequence will stop.  

Note: (To "latch" the Sequencer, press [LATCH] so it is lit. When this button is activated, Sequencer playback will continue even 
after the key is released.) 
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Pro Tools 
 
You can use MAX49 with Pro Tools or any other DAW that uses the HUI protocol. Using this protocol, MAX49 will act as a 
control surface for the DAW. To do this: 
 
1. On MAX49, press [SHIFT] + [HUI]. 

2. Connect MAX49 to your computer with the included USB cable. Open Pro Tools. 

3. In Pro Tools, go to Setup  Peripherals, and select the MIDI Controllers tab. 

4. Select HUI as the #1 Type. 

5. Select AkaiMAX49 Mackie as the #1 Receive From and #1 Send To. 

6. Optional: To enable MAX49's KEYBOARD to play MIDI notes while using its other controls as a Pro Tools control 
surface, select M-Audio Keyboard as the #2 Type, and select AkaiMAX49 Port A as the #2 Receive From and #2 
Send To. 

 

Chromatic 
 
MAX49's Chromatic Program is a general preset where the 12 PADS' note messages are based on the chromatic scale. 
All PADS will send Note On messages, ascending chromatically from C2 (Pad 1, Pad Bank A) to B5 (Pad 12, Pad Bank 
D). 
 
The PADS are set to MIDI Channel 2, the Sequencer is set to MIDI Channel 3, and the KEYBOARD is set to the Common 
Channel. 
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